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Our Summer 2020 Release includes:

WHAT YOU’LL The new Help Request System

LEARN Integrations for firearms and accounting

Expanded mobile device support and apps

New Point of Sale features
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z Paladin Point of Sale

File Edit Maintain Tasks

§ S

nvoice/Quote | Customers

Reports
3 Support ~ I & 6
I \\\\ Chat Sfupport j
B Submit a Help Request p
Inventory View Active Requests P
Training Videos
Knowledge Base
Remote Connection
Upd; Check For Updates
About

A 4 Details on new and upcoming Paladin POS fe:

l ] undates are listed below:

A new Support category on the Help menu
provides access to Chat Support and the
new Help Request Portal.

Submit a Help Request replaces the “Open
a New Case” menu option which opened in a
browser window. This new Help Request
Portal Is integrated into Paladin.

View Active Requests replaces the “My
Cases” page on the Help Portal website.
This feature also opens in Paladin.
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« Cannot upload an order to a supplier

« Cannot process a sale on any terminal

Submit a Help Regquest

Tell us how we can help

Category Subject
\‘"j Place an order with Paladin \}? Paladin POS will not start
\:j'- Request training \}7 Login and passwords
\:A}:- Paladin POS software or Managed Services
[ F St Login Posvorts—

Invoice / Quote

Customer Management

Qﬁ Third-party software or integrations
\3:_ Credit cards
\‘"j Hardware issues

Description *

| need a password reset]

Contact Information

o

Phone: [(123) 4567830

| %

Email: |rnar3.I @paladinhardare. com

Code: ||f provided by Paladin Support

|
—
\.4'"

Submit

Answer the store-down emergency
guestion and then fill out the Help
Request form.

Select a Category and Subject that
best fit your issue. Accurate
selections will expedite your request.

Enter a detailed Description and a
contact Phone and Email.

Attachments can be added after you
submit the request using Help >
Support > View Active Requests
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T | ® v s YourHelpRequest#1... pd .
File Message Help 7 Tell me what you want to do After you Su bmlt a. neW Help
v & Biv S >8Ry By |~ Request, you will receive a Help

Request ID.

Your Help Request # 158817 has been received

Re S S| |- i .
o e oo This ID will also be sent to the

We have received your request for help. A Paladin Support specialist will follow up with ContaCt em all address you
you using this email or the phone number you provided. entered
Sincerely,

The Paladin Support Team
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You'll experience even more efficient and responsive
support due to these enhancements:

Fully-integrated into Paladin and automatically collects
vital data about your unigue system when help is
request.

Categories quickly direct your request to the most
knowledgeable support team.

Our products and customer service are
continually optimized based on the data we collect.
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FastBound integration

Simplify the complicated process of
selling firearms with the FastBound
Integration.

Guaranteed compliance for firearm

acquisition and disposition (A&D),

FAST BObf]D an electronic 4473, and an
electronic bound book with

FIREARMS COMPLIANCE SOFTWARE FastBound’'s FFL software.

Receive and sell firearms in Paladin

while simultaneously updating

FastBound A&D and your electronic
bound book.




& UNIVERSITY

QuickBooks Online integration

QuickBooks integration now
supports the online version

Sync the day’'s general ledger
@ activity summary to your

QuickBooks Online general ledger

EUCIICkbOO ks each night.

Automatically create an accounts
payable invoice from a purchase
order, minutes after you receive new
product and close a purchase order
In Paladin.
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Amount

e $ 505.00|

EMV chip slot
Barcode scanner

Card swipe
Fingerprintreader

Take the power of Paladin with you anywhere on
your business network with this agile 10-inch
Windows tablet

Use all Paladin features including inventory
management, EDI, purchase orders, pricing
plans/sale lists, quotes and customer sales

Barcode scanner and EMV enabled. Runs Office
365 and other Windows programs

EMV Level 3 certified. Compatible with WorldPay
and DataCap. Supports signature capture.

Connect your store’s database, printers and other
peripherals via WIFI
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Android device optimized for
Mobile2Checkout and many other partner
applications

Sell anytime and anywhere with an internet
connection (cellular or WIFI)

Collect signatures and process payments

Optional uDynamo card reader available
with the bundle

Compact 8-inch form factor makes device
easy to hold and use

Card reader Rugged tablet with water-resistant S Pen
and screen
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User-friendly, multimedia touchscreen
payment processors with built-in signature
capture PIN pad.

Accept all major payment types, including
touchless, and features a stylus for quick

signature capture.
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Mb"éi‘:”s"zcnscnour
> INVOICE

Works on most newer Android devices

01-Jun-20 12:12:41 PM

- Sell anytime, anywhere
e K Accept multiple tender types, including cash,
rResuaRPRCE R check, debit/credit cards, gift cards, and

Hia charge on account

Store orders and process returns

Ak NEW! Recall stored quotes and checkout on

e your mobile device
NEW! Respect pricing plans and trade
discounts.

Requires version 1.1.1 or higher
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A new inventory setting (checkbox) lets you show
Y B S prices in thousand board feet (MBF), thousand
BT square feet (MSF) or ton on invoices and quotes.

& 5.99) | 0.00| \
PO: [ 224625|[  0.00] Costpen‘m: v

Pricing Levels _ , - IMBF: Net: [ |
I r L

s sl

To turn on, select the MBF, MSF or TON checkbox.
(Cost Per: must be set to unit first.)

Rewards !:l Customer ‘ v‘ Address 2 Phone \:’
Credit Address 1 . Fax
MBF price
o E|':|"f| 'b“" Part Number , Qu Price ‘ Extension
0O O LUMB12 PINE1inx4i EACH "1 $ 483375 $ 12.89
LUMB12 4,833.75 invoice quantity and price (EACH) L;
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Invoice / Quote

oo 1)

Rewards |123456789 | Customer |100 - MARY SMITH V| Address 2 Phone (1234567890 |
e Ml e Calculate square foot quantities
"{ [l’:ﬂ 'l‘_—‘]’t’ Part Number | Description Quantity Price ’ Extension

n | LomBas HARDWOOD FLOORING Meivansg T for an invoice item based on

M 010

! o | R dimensions (width/length) and #
quare Footage Calculator Cancel Profit Analyst (Alt + A) .
e I pieces that you enter.
Quantities are recorded in a note.
i L Right-click the item to access the
Copy (Ctrl + C) 3.99 -
\ N e ——— calculator from the Quick Access
Ad ‘ Total $ 4.37
L IR menu or press Ctrl + S
Eﬂ%ﬂ'gﬂr— Part Number Description : it
M O O LUMB345 HARDWOOD FLOORING EACH 10340 $ 39 $ 412.57

20@1-8.00X2-6.00 10@1-0.00X2-0.00
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Rewards Customer [100 - MARY SMITH

Credit 0.00 Address 1 100 MAIN ST

Thanks for shopping with us!

Incremental quote numbers can be
Your Local Hardware :
— automatically added for easy
4 O O 21095 6 X 5/8 PH FL WOOD 123-45'5-7399 reference.

B"’ [[)]ef[ "E‘]’t] Part Number ’ De;
Quote #6

(] 21095 1.29
O O 21090 4X1/2PHFLWOOD § MARY SMITH . .
PRETTY CITY, o8 1284 Find quotes quickly by number
1234567890 ACCOUNT &: 100 .
Cmomioce (EECTTRER | — when your customer is ready to
Rewards | Customer 100 - MARY SMITH Quote # 6 b
Credit 0.00 Address 1 100 MAIN ST 21095 S 00 1.29 .45 uy-

EACH
6 X 5/8 PH FL W0O0OD SC 2N

o _ Turn on quote numbers in File >
| (?i(/ [] Show for all customers Setup > InVOice (Store) tab,
select Enable Quote Numbers.

O Suspended Sale (© Quote — Order

Mary Smith Quote # 6: Office remodel
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Paladin Point of Sale

File Edit Maintain

Start Date End Date
03-Feb-20 )~ | | 03-Feb-20

Tasks Reports Help

@~ | |ALL

Record

Supplier
PP Type

EDI SUPPLIER Inventory

EDI SUPPLIER Promotiona

EDI SUPPLIER Price Change

0024130

Process
Date

03-Feb-20 13:35
03-Feb-20 13:34

03-Feb-20 10:18

Employee Processe d of Lin:

1"
1"

All Lin

Y

~
Nu mbe Rec. Cost Rec Freight
137 $0.00
$0.00

192 $4,131.48

eeeeeeeeee

Serial # &

Apply a freight cost to an EDI
Invoice and then distribute the cost
across its received items in the EDI
Reporting window.

Freight column icons identify
Invoices that are eligible for a freight
cost (&) and invoices where freight
has been applied ().

This feature is already available for manual receiving.
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Apo kel SRl Freight costs can be distributed by item cost
*+ A Apply a freight cost to received items Or Item Wel g ht
Enter a freight cnst_and E:hnose how t_n di?.tribute TI p It S a beSt praCtlce to apply frelght COSt
the cost to received items on the invoice. soon after the EDI INvoice IS processed and
IMPORTANT: I_f you distribu?e freight by weight, a frei_ght cost will . .
not be applied to 6 of 89 items because no weight is defined. before recelved |tems are SOId .

Distribute Freight Cost by:

Item Cost v Freight Cost: |100.00

Item Weight

| Cancel | | FBOK |
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Invoice 18957

Your Local Hardware Store (_) «) -
To Mary Smith 2:13 PM

Invoice 18957.pdf
me | 73KB

We appreciate your business and look forward to seeing you
next timel

Your Local Hardware Store
(123) 456-7890
Hours: Mon-Fri 8-8 | Sat 9-6 | Sun 11-5

Add custom message, your
store hours, a note about
upcoming promotions or other
custom text when your client
opts for an email invoice.

Enter your text in File> Setup
> Forms tab > Email
Message box.
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B [owce €3]
PO # | “‘T Supplier{ VT Address 2 Phone | | Create a_ neW purChase
EDI | »Address1 | CltyIS:ételltp : Fax Order form a PO Wlth

PO Details MatchlngPurchasoOrders baCkordered |temS
i Enter the PO details below: Vendor PODateV‘fltems} PO Cost I Rcvd Cost | jiCloved . . .
m— m- “Il| - The existing PO will be
@® Open POs MY BEST SUPPLIER 20-Mar-20 1 $300.00 $150.00
OClosedPos closed and a new PO
Supplier [0 -All v
3 created for the
o (. W backordered items.
To Date |20-Mar-20 @~ |
To access this feature,
use Find PO to locate
VRcvdltemsReport Rcvd POs Report PrintnemTags VCreateItemTagFile N VCance the purChase Order and
e e e B i i o i B then click Revise PO.




& UNIVERSITY

Purchase Order Confirm PO
~ ol

The new PO name is
= prefixed with “Revise
422/ st e PO” and contains the
; o s eassien -l prior PO’s #.

( Revise PO 142 Revision of PO 142 - Original Emp: 29 Date: Mar 20, 10:59 20-Mar-20 11:15 .

It appears automatically
in the Recall
Transaction window.

Address 2

29

Autosave-5-Store Manager

20-Mar-20 10:31 29

[ View in Excel | [ Delete | [ F12 Recall |
H
- Z= k 7Y ol e
A @ AL S LA NI
Advanced Edit Delete Mode Recall Confirm Total $ 0.00

Lookup Note Line Item PO | Receive PO Stock Check PO
|
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Purchase Order m .

A LI EE———— Add decimal places to line item
ST e Besartor | quantities and prices on
____________________________________ T o ]| B | e . purchase orders.
@ - — To add more precise values,
right-click the line item and
= select Add Precision from the

Quick Access menu.
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Paladin Point of Sale (&)Xl
File Edit Maintain Tasks Reports Help

\ = 1 2 3 y “ 4 g 5 Q¢ |6 7 8 secus 9
VS T et o S ARICE
nvoice?uote Customers InIverEry ‘:O Repo:s ;;;(up Exit Your Imware Store M j m S C h e d u I e re po rtS to r u n O n

. . _ —— weekdays only with a new
Daily — Exclude Weekends

option.
@  Report Preset 1 - Inventory Valuation Summary et name: Receiving Report
@ Report Preset 2 - Accounting Summary Report T
|Rcvng Report
@ Report Preset 3 - Today's Register Balance :
@ Report Preset 4 - Today's Comparative Revenue Schedule report:
@ Report Preset 5 Click Next to select
(> Report Preset 6
- Sunday
@ Report Preset 7 Weekly - Monday
@ Report Preset 8 Weekly - Tuesday
Weekly - Wednesday
@ Report Preset 9 Weekly - Thursday i
Weekly - Friday
Weekly - Saturday
Monthly
F1 CF2 CJm C|Fa CFs F6 F7 F8 F9 F10 1

~qr- ——
1 IRe2 1Re 3 IR 4 SO IRCO MRS T IRe S ARSI, N>

Inv Val Acct Summary today's regist Today's Rev None None None None None Recall Reports | Create Preset
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Credit Card Deposit

Report Settings
Selection Beginning Ending

InvoiceDates 02-Feb-20 O~ | [02-Feb-20 B-| VIeW and analyze Credlt Card

Searchy O Tormina © Employee transactions easily with a new
xport to Excel? % — .
Frponio® Excel option.

Autasve @D [ 9 Book2 - Excel The Excel workbook includes

File Home Insert Draw Page lLa Formule Data Review View Add-ins Help Team © Search 2 = k h b
E— —— .| separate worksheets (tabs)
|« : e : ! | - for each employee or
1 |Invoice # Date Card Number Card Type Name Amount Auth Number
> . .
2 9993 01-Feb-208:29:55 AM  ***=*=*sx220441 VISA MARY SMITH 2.69 111111 t m I d p d g th
3 10023 02-Feb-20 8:50:33 AM + ******++x+£21060 V/|SA DAVID OWEN 14.99 222222 er Ina ) e en In On e
| | A
4 10029 02-Feb-20 10:06:24 AM *******xxx%%£1893 VISA JOHN DOE 78.38 333333 - h
5 10039 02-Feb-2012:09:00 PM *****x*xxxxx%£6987 VISA SUSAN BLACK 19.99 5;44444 Optl On you C Oose .
6 10041 02-Feb-2012:16:17 PM  ******xxxx+23551 M/C SARAH JONES 149.56 '555555
7 10051 02-Feb-20 1:59:21 PM  *****xxxxxx%3813 VISA BOBBY WHITE 4.49 '666666 -
» Report Settings All Employees Employee 2 Employee 3 Card Type Details ... (¥
Ready 23 B Display Settings HH g~ i + 100%




&> UNIVERSITY

View a Customer Friendly version of the Excel Transaction Report that
omits department, cost and margin data.

If you want the original view, select Accounting Department.

Transaction Report - Excel Canct

Report Settings - limited to a maximum of 31 days Additional Settings
Selection Beginning Ending Show invoice notes O
Invoice Date* ’16-Jul -20 @~ | |16-Jul -20 B~ ] Skip account payments

PartNumber { ‘ lzzzzzzzzzz Detail Display ® customer friendly () Accounting Department

Toroainal [n ] [n{mnnnm'm
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Prevent special orders from earning
rewards.

Avallable for Ace Rewards, Rich
Rewards or Repeat Rewards.

Create a new no-rewards class (method
varies by rewards program), and set
Default Class for Special Order Items
(Company tab) to the class ID.
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Device Manager

Encrypted Device Input Manager

y 2
&

Please make your entries in the attached payment
terminal.

Manual Entry

| Cancel

For EMV-enabled stores, a new
checkbox lets you optionally swipe a
credit card to put it on-file in Paladin.

This feature is already available for
stores that are not setup for EMV.

To swipe the card instead of manually-
enter the card number, when you start
the on-file process, in the Device
Manager window, clear (deselect) the
Manual Entry checkboxthatis
selected by default.
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For additional details, view the

Summer 2020 Release Guide



https://portal.paladinpos.com/release-notes/new-features/summer-2020-release-guide
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Q&A
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Next Webinar:

Streamline Firearms Sales with FastBound
August18 @ 9am PT

Register: portal.paladinpos.com/webinars


https://portal.paladinpos.com/webinars/

& UNIVERSITY

Check out our Summer 2020 Release Guide on
the Help Portal.

Expand your Paladin Knowledge:

Stay relevant in retail: Webinars available at:
paladinpointofsale.com/retailscience portal.paladinpos.com/webinars
Self help at: Follow us for Paladin news and updates:

portal.paladinpos.com ﬂ m u



